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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid 
Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product 
may only be used in accordance with the license agreement.

Media Composer Family, including Media Composer, EDL Manager, FilmScribe, Marquee, Mojo products, Nitris DX, Avid 
Artist Products, ScriptSync, and Symphony

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,355,450; 5,396,594; 
5,440,348; 5,528,310; 5,557,423; 5,577,190; 5,584,006;  5,724,605; 5,726,717; 5,745,637; 5,752,029; 5,754,851; 5,812,216; 
5,905,841; 5,959,610, 6,057,829, 6,091,778, 6,105,083, 6,118,444, 6,141,691, 6,160,548, 6,201,531; 6,269,195; 6,330,369; 
6,336,093, 6,353,862, 6,404,435; 6,407,775, 6,426,778; 6,477,271, 6,489,969; 6,512,522; 6,546,190; 6,552,731, 6,553,142; 
6,570,624; 6,571,255, 6,583,824; 665,450; 6,678,461; 6,687,407; 6,704,445; 6,728,682, 6,747,705; 66,763,134,6,766,063; 
6,791,556; 6,810,157, 6,847,373; 6,871,003; 6,871,161, 6,901,211; 6,907,191; 6,928,187, 7,043,058; 7,081,900; 7,103,231; 
7,145,567; 7,266,241, 7,280,117; 7,403,561; 7,433,519; 7,441,193, 7,545,957; 7,671,871; 7,684,096; 7,725,812; 7,729,423; 
7,916,363 ; 7,930,624; and D515,095, D396,853. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 
0674414; 0752174; 0811290; 0811292; 0811293; 0857293; 0976108; 0988756; 1050048; 1068734; 1111910; 1173850; 
1629675. Other patents are pending.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be 
covered by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 
and/or other patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

Copyright © 2011 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use 
of this software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players 
and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample 
Source Code:
©1993–1998 Altura Software, Inc.

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

http://jcifs.samba.org/
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Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, 
Assistant Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, 
Avid DNxcel, Avid DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, 
Avid Mojo, Avid Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, 
Axiom, Beat Detective, Beauty Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, 
CaptureManager, ChromaCurve, ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, 
Command|24, Command|8, Conectiv, Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, 
Dazzle Digital Video Creator, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, 
Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, 
Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, DPP-1, D-Show, 
DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, 
FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE HDCAM, 
iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, 
Intelli-sat Broadcasting Recording Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, 
iS23, iS36, ISIS, IsoSync, KeyRig, KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, 
Luna, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, MassivePack, 
Massive Pack Pro, M-Audio, M-Audio Micro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, 
Media Reader, Media Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, 
Mix Rack, MixLab, Moviebox, Moviestar, MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, 
NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF Interchange, OMM, OnDVD, Open Media Framework, 
Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, Personal Q, PET, Pinnacle, Pinnacle DistanTV, 
Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile Media, Pinnacle Scorefitter, Pinnacle Studio, 
Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory, PowerSwap, PRE, ProControl, 
ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch, QuietDrive, 
Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket Surfer, 
Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay, 
SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, 
SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, 
Studiophile, SubCap, Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, 
SYNC I/O, Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, 
TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, 
Torq Xponent, Transfuser, Transit, TransJammer, Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, 
Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, 
X-Session, and X-Session Pro are either registered trademarks or trademarks of Avid Technology, Inc. in the United States 
and/or other countries.

Trademarks
Avid, the Avid logo, and ScriptSync are trademarks or registered trademarks of Avid Technology, Inc. in the United States 
and/or other countries. See www.avid.com/US/about-avid/legal-notices/trademarks for more information on Avid’s trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other 
countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
countries. All other trademarks contained herein are the property of their respective owners. 
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1 Purchasing and Activating ScriptSync

The ScriptSync option is sold separately from your Avid editing application. Once you purchase 
ScriptSync, you will receive a ScriptSync Activation ID that you use to activate the ScriptSync 
feature. You activate the ScriptSync feature with the Avid License Control tool. To find out the 
benefits of the ScriptSync feature, you can try out ScriptSync for a free 30-day trial period before 
you purchase.

You can also purchase and activate multiple seats of ScriptSync. For information about installing 
and activating volume licenses see the FlexNet Device Manager for Avid Guide on the Avid 
Knowledge Base.

For more information about ScriptSync, see:

• Purchasing and Activating ScriptSync

• Marking with ScriptSync

How Do I Purchase ScriptSync?
• You can purchase ScriptSync through your Avid Reseller. 

• You can purchase ScriptSync from your Avid editing application’s Script > ScriptSync 
menu.

• You can purchase ScriptSync directly through the Avid web store at http://shop.avid.com, 
then search for ScriptSync.

How Do I Activate ScriptSync?

Once you purchase the ScriptSync feature and have received a ScriptSync Activation ID, you 
activate this option through the Avid License Control tool in the following ways:

• You can use an Internet connection to activate ScriptSync. Avid License Control tool lets 
you activate online using your system identification (System ID) number and the Activation 
ID that came with the purchase of ScriptSync. 

• If the system running your Avid editing application and ScriptSync is not connected to the 
Internet, you can activate ScriptSync by using a different computer with an Internet 
connection. 

http://shop.avid.com
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• If you do not have access to the Internet, you can activate ScriptSync over the telephone by 
calling Avid customer service. 

• You can activate multiple ScriptSync licenses using the FlextNet Device Manager for Avid. 
For more information, see the FlexNet Device Manager for Avid Guide on the Knowledge 
Base. 

What Will I Need to Activate ScriptSync?
• The ScriptSync Activation ID (obtained after you purchase ScriptSync)

If you purchased through an Avid Reseller, the ScriptSync Activation ID is on a sticker 
adhered to your Instruction letter. If you purchased through the Avid web store, you receive 
your ScriptSync Activation ID through an Avid e-mail or you can also view your Activation 
ID by logging in to your Store account at http://account.avid.com/.

• Your System ID
This number pre-displays if you have activated your Avid editing application. If the System 
ID does not appear, you can get the number in the following ways: 

- The License Profile tab of the Avid License Control tool

- If you purchased your Avid editing application online, you received your System ID 
from Avid by e-mail

- The Avid editing application splash screen (Help > About Avid editing application)

- The Console of the Avid editing application (Tools > Console, then scroll to System ID)

- The inside cover of your Avid editing application Installation Guide

- If you purchased your Avid editing application from the Avid store, you can also view 
your System ID number by logging in to your Store account at http://account.avid.com/

If you have a dongle attached to your Avid editing application, check the License Profile tab 
of the Avid License Control tool or use DongleManager to obtain your System ID. See the 
steps below for information about this utility.

• Your Device ID (you only need this if you are running ScriptSync on a system without an 
Internet connection). Check the License Profile tab of the Avid License Control tool.

To retrieve your System ID with a dongle attached:

1. Navigate to one of the following locations:

t (Windows) Program Files\Avid\Utilities\DongleManager

t (Macintosh) Applications/Utilities/Avid Utilities/DongleManager

2. Double-click DongleManager.

A window opens and displays your System ID.

3. Copy the System ID, and then close the terminal window.

http://account.avid.com/
http://account.avid.com/
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Running the 30-Day Trial of ScriptSync
Before you purchase ScriptSync, you can try it out for a 30-day period. After the 30 days, if you 
do not purchase ScriptSync, you will no longer have access to the ScriptSync feature. The 
system keeps you informed of how many days you have left before the trial period ends.

n If you are running the Avid editing application trial version, you do not need to run the trial 
version of ScriptSync. The ScriptSync feature is included with the trial version of the Avid editing 
application.

To run ScriptSync for a 30-day trial period:

1. Open your Avid editing application and an Avid project.

2. Create a script, File > New Script.

3. Browse to your script then click Open.

4. In the script, click the section where you want to place the clip (take).

The section highlights.

5. From a bin, drag the clip to the selected section in the script.

The box below the clip in the script, should highlight black. This indicates that the clip is 
selected in the script.

6. Select Script > ScriptSync.

The system checks to see if you have ScriptSync on your system and then a dialog box 
opens.

7. Click Run Trial.

Your trial is activated. 

8. Click Continue to begin using ScriptSync for your 30-day trial period.

To purchase ScriptSync during your 30-day trial period:

1. Open your Avid editing application and an Avid project.

2. Create a script, File > New Script.

3. Browse to your script then click Open.

4. In the script, click the section where you want to place the clip (take).

The section highlights.

5. From a bin, drag the clip to the selected section in the script.

The box below the clip in the script, should highlight black. This indicates that the clip is 
selected in the script.
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6. Select Script > ScriptSync.

A dialog box opens which informs you of how many days you have left on your 30-day trial. 
This message displays with the remaining time only when you restart the Avid editing 
application and click ScriptSync again.

7. Click Buy.

The system opens the Avid web store, allowing you to purchase ScriptSync. Once you 
purchase ScriptSync and obtain your ScriptSync Activation ID, you can activate ScriptSync.

A dialog box opens informing you that Activation will quit your Avid editing application 
and launch the Avid License Control tool.

8. Click Continue.

The Avid License Control tool opens.

To activate ScriptSync, see “Activating ScriptSync with the Avid License Control Tool” on 
page 11 to continue.

If You Purchased ScriptSync Through Script > 
ScriptSync Menu Selection

If you are working in your Avid editing application, you can select Script > ScriptSync to 
purchase the ScriptSync feature. You will need an internet connection and you will be directed to 
the Avid store. Once you make your purchase, you will receive your ScriptSync Activation ID 
and be directed to the The Avid License Control tool to activate the ScriptSync feature. 

To purchase ScriptSync through the Avid editing application’s Script > ScriptSync menu:

1. Open your Avid editing application and an Avid project.

2. Select Script > ScriptSync.

A dialog box opens which informs you that ScriptSync is not activated on this machine.

3. Click Buy.

n If you have not purchased ScriptSync and if the Buy button does not appear, close and restart 
your Avid editing application. Repeat the steps above.

The system opens the Avid web store, allowing you to purchase ScriptSync. Once you 
purchase ScriptSync and obtain your ScriptSync Activation ID, you can activate ScriptSync.

A dialog box opens informing you that Activation will quit your Avid editing application 
and launch the Avid License Control tool.

http://shop.avid.com/store/home.do
http://shop.avid.com/store/home.do
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4. Click Continue.

The Avid License Control tool opens, which allows you to activate ScriptSync.

To activate ScriptSync, see “Activating ScriptSync with the Avid License Control Tool” on 
page 11 to continue.

If You Purchased ScriptSync through an Avid 
Reseller or Directly Online

Once you purchase ScriptSync, you will receive your ScriptSync Activation ID. You need to 
open the Avid License Control tool to activate the ScriptSync feature. 

The Avid License Control tool is installed with your Avid editing application and is located in 
the Utilities folder.

To open the Avid License Control tool:

1. Open the Avid License Control tool from your Avid editing application. Go to the following 
location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens.

To activate ScriptSync, see “Activating ScriptSync with the Avid License Control Tool” on 
page 11 to continue.

Activating ScriptSync with the Avid License Control 
Tool

When you purchase ScriptSync and open the Avid License Control tool, you are ready to activate 
the ScriptSync feature. You can only use and activate ScriptSync on a single machine at one 
time. 

If you have an Internet connection on the machine that you will be using ScriptSync, follow the 
instructions “To activate ScriptSync with the Avid License Control tool and with an Internet 
connection:” on page 13. If you do not have an internet connection, follow the instructions “To 
activate ScriptSync with the Avid License Control tool and with no Internet connection:” on 
page 16.

For more information on how to open the Avid License Control tool see, “If You Purchased 
ScriptSync Through Script > ScriptSync Menu Selection” on page 10 or “If You Purchased 
ScriptSync through an Avid Reseller or Directly Online” on page 11.
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To open the Avid License Control tool:

1. Go to the following location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens, this allows you to activate or deactivate ScriptSync.

The Status column displays whether ScriptSync is Activated, Not Activated, Deactivated, or 
Trial. 

The Action button displays as Activate or Deactivate.

To copy system information from the License Profile tab:

1. With the Avid License Control tool open, click the License Profile tab.

The License Profile tab displays information about your system, including: Device ID, OS, 
System ID, Activation ID, software Version, if your software is activated or deactivated.

2. Click Copy.

The information copies to your Clipboard.

You can cut and paste from the clipboard to an e-mail or create a text file, if you need to send 
system information to Avid Customer Support.
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To activate ScriptSync with the Avid License Control tool and with an Internet connection:

1. With the Avid License Control tool open, click Activate next to ScriptSync.
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A dialog box opens.

2. If your computer has an Internet connection, select “I am connected to the Internet and will 
use this computer.” 
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3. Click Continue.

The Avid Activation dialog box opens. 

4. Enter your system identification number in the System ID text box. 

This number pre-displays if you have activated your Avid editing application. If the System 
ID does not appear, see “What Will I Need to Activate ScriptSync?” on page 8 for more 
information.

n If you have a dongle attached to your system, the system should pre-display your System ID.

n You can copy and paste your system identification number and your Activation ID from a text file 
to the appropriate text boxes.

5. Enter your ScriptSync Activation ID in the Activation ID text box. 

Your Activation ID is located on the ScriptSync Instruction letter if you purchased through 
an Avid Reseller. If you purchased ScriptSync online, you received your Activation ID from 
Avid by e-mail. For more information, see “What Will I Need to Activate ScriptSync?” on 
page 8.

6. Click Activate.

The Activation tool confirms your system information.

ScriptSync successfully activates.
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To activate ScriptSync with the Avid License Control tool and with no Internet connection:

1. With the Avid License Control tool opened, click Activate next to ScriptSync.

A dialog box opens.

2. Select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet.”

3. Click Continue.

The Avid Activation dialog box opens.

4. On the second computer open a Web browser and navigate to http://avid.com/license.

The Avid Software License Activation page opens.

5. In the Software License Activation Web page, enter your Activation ID and if you would like 
to have your Activation file sent to you, enter your e-mail address. 

To find your Activation ID, see “What Will I Need to Activate ScriptSync?” on page 8.

Once the system verifies your Activation ID, the Device ID and System ID entries display.

6. Enter your Device ID and System ID.

To find your Device ID or System ID, see “What Will I Need to Activate ScriptSync?” on 
page 8.

7. Click Activate.

The system creates a license.bin file. This file contains license information needed to 
activate ScriptSync.

If you entered an e-mail address, the .bin file will be sent to you as an attachment. You can 
also download the .bin file directly from the site.

8. Click Download to download the license.bin file to your system.

Depending on your web browser, the license.bin file could be located on your desktop or in a 
download folder. 

9. Move the license.bin file to the system you need to activate ScriptSync. 

You can use a removable storage device such as a USB drive or you can transfer the data 
over your network.

10. Open the Avid License Control tool. 

11. Click Browse and navigate to the license.bin file you moved to your system, then click 
Open.

The Avid License Control tool confirms your system information. When the activation is 
complete, a message informs you that ScriptSync has been successfully activated and the 
button changes to Deactivate.

http://avid.com/license
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Deactivating the ScriptSync License 

n If you need to move ScriptSync to a different computer, deactivate the ScriptSync license.

n You must have an Internet Connection to deactivate ScriptSync.

n You do not need to deactivate the Trial version of ScriptSync.

Deactivating ScriptSync

1. Open the Avid License Control tool from your Avid editing application. Go to the following 
location:
(Windows) Start/All Programs/Avid/Utilities/License Control
(Macintosh) Applications/Utilities/Avid Utilities/License Control

The Avid License Control tool opens.

2. Next to ScriptSync, click Deactivate.

ScriptSync deactivates and the button changes to Activate.

You will need to follow the instructions on how to activate ScriptSync if you want to activate 
it on another computer.
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2 Avid ScriptSync

The Avid automatic alignment for ScriptSync™ feature, purchased separately, phonetically 
indexes text and audio dialogue and synchronizes the two together. Avid ScriptSync uses 
traditional lined scripts or transcripts that you import into an Avid editing system to 
automatically associate the media clip with the text of the script. You can then easily and 
accurately search and instantly access the targeted content during the editorial process.

The types of customers who might use lined scripts or transcripts include: multi-camera sitcoms, 
film based shoots with dialogue, episodic television shows, feature films, documentaries, and 
reality television shows with spoken raw footage. With one click you can find any word or 
sentence within a lengthy interview.

This booklet helps you install the Avid ScriptSync feature, gives a brief introduction about 
line-scripts, and includes steps on how to use the Avid ScriptSync option. 

For detailed information about using scripts and how to manage your script-based media, see 
“Script-Based Editing,” in the Avid editing Help.

For information about Avid ScriptSync, go to 
www.avid.com/US/solutions/workflow/Scriptbased-Editing.

Understanding Lined Scripts
The conventional lined script evolved during decades of trial and error in Hollywood. It provides 
assistant editors and chief editors with a road map that helps them find the coverage they need to 
edit scenes in a film or television show. 

The script-based editing feature in your Avid editing application lets you adapt the lined script to 
the digital realm for use in any type of production, from drama to documentary to spot 
advertising. For more information, see “Script Integration — Lining in the Digital Realm” in the 
Help.

http://www.avid.com/US/solutions/workflow/Scriptbased-Editing
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A traditional lined script is created by hand at the time of shooting. The following is an example 
of a scene from a lined script.

Each vertical line drawn through the scene represents a single take from the moment the director 
says “Action” to the moment the director says “Cut.” Each scene might require several camera 
angles and positions, with one or more takes, all of which are lined and identified 
alphanumerically. 

The following table summarizes the lining techniques and numbering system shown in the 
example.

33/1

33A/1 33A/2

33B/133B/2
33B/3

33C/1 33C/2

Master shot The line labeled 33/1 is the master shot that usually covers all the action in a wide 
shot. The first number in the label indicates the scene number as written on the script 
(scene 33). The number following the slash indicates that this is the first take captured 
on film for the master shot. A second take of the master shot, for example, would be 
labeled 33/2.
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When the scene is recorded — for example, in a sitcom shoot — the lined script can also include 
timecode notes written next to specific lines of dialog that represent a sync point between the 
dialog on the page and the recorded dialog. These sync points provide assistant editors or chief 
editors with a quick path to specific points in the source material.

Marking with ScriptSync
[IDH_ScriptSync above]

Some Avid editing applications include the ScriptSync feature (purchased separately). 
ScriptSync uses phonetic-indexing technology from Nexidia™ to analyze the audio portion of a 
clip and match it to lines of the script text.

To add script marks with ScriptSync:

1. Select one or more takes that include audio. 

2. Double-click any line in the take to select the take and load it into a monitor.

Additional 
setups

The lines for each subsequent camera setup within the scene are labeled with the 
scene number (33 in our example) followed by a letter for each setup, followed by a 
slash and the number of the take within that setup. These lines can be any length, 
depending upon what portion of the script is covered by the particular shot.

Off-screen 
dialog

The jagged lines in the script represent the parts of dialog where the actor is off 
screen. For example, the character Mary Sue is off camera during the action described 
in the second paragraph (when the waitress character enters), so a jagged line is drawn 
through the shots that cover Mary Sue (33A/1 and 2).
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3. Select Script > ScriptSync.

The ScriptSync dialog box opens.

4. Select options as described in the following table.

Option Description

Language Select the language of your script (this setting is for both the audio and 
the text).

n Depending on the language you select, the Acoustic model 
(Broadcast or Telephony) that Nexidia uses changes. Only one 
model applies per language. Broadcast has a higher resolution 
and can be more accurate than Telephony in some cases. The 
Broadcast model is used for North American English, Dutch, 
Latin American Spanish, and Modern Standard Arabic.

Tracks Select the audio tracks you want as input to ScriptSync.

Skip lines that only 
contain CAPITAL 
letters

Select this option if lines that contain only all-capital letters are not part 
of the spoken dialog. Dramatic scripts often use all-capital letters to 
identify the speaker or for scene descriptions. 

Skip text in 
parentheses ‘()’ or 
brackets ‘[]’

Select this option if parenthetical expressions in your script are not 
spoken.
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5. Click OK.

The syncing process starts and displays a progress tracker.

6. (Option) Press Ctrl+. (period) to cancel the process after it has started.

When ScriptSync finishes, your take includes a script mark for every line of text your Avid 
editing application found in the audio.

7. Check through the marks. If ScriptSync missed any, add them manually as described in 
“Placing Script Marks Manually” in the Help.

Skip text before 
colon ‘:’

Select this option to skip all text before the first colon in a line of text. 
For example, select this option if your script uses the convention of 
placing a character’s name before a colon when the character begins to 
speak.

Skip lines indented 
less than dialog

Select this option if action is indented less than dialog in your script. If 
you select this option, type the number of characters that dialog is 
indented in the Dialog Indent (characters) text box, or click the Select 
Dialog button, select a line of dialog from the Script so your Avid 
editing application can automatically infer the correct number of 
characters, and then click OK.

Overwrite existing 
marks

Select this option if the take you are syncing already contains script 
marks and you want ScriptSync to update those marks.

Option Description
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